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Chapter1  _ntroduction

uide describes the Real-Time Position Management Respiratory
ing System 1.7. The system helps you decide upon and implement
tumor treatment plan that accounts for the patient’s breath, targets

q the tumor more effectively, and reduces delivery of dose radiation to

adjacent healthy tissue.

This guide is written for reference by the following personnel:
m  The team planning a treatment

m  Radiotherapists and other operators of the system

m Installers of the system

Guide Structure

The chapters of the guide pertain to task areas as follows:

m  Learning the components of the system and the graphical user
interface of the software

m  Making initial planning decisions before recording data for
breathing-synchronized simulation images acquired on CT or PET
equipment—prospective gating —for a field

m  Recording data for breathing-synchronized simulation image
sequences acquired on 4D CT or PET equipment for a field,
deferring planning decisions. The planning decisions take place in
retrospect, based on the recorded data and acquired image
sequences for the field.

Visual Conventions

This guide uses the following notational conventions to help you
locate and identify information.

Italic text is used for emphasis, examples, new terminol &xt th o

you type, and book titles. o
\y {0
x
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Bold text @tiﬁes menu names and commands, items you can click
or selec e screen, keyboard keys, and names of hardware
contr

pe font identifies file names, folder names, text file
nts, and text that either appears on the screen or that you are
uired to type in.

from that menu. In this example, click the View menu, then click the

% V1ew > Options indicates selecting a menu, then selecting a command
Q Options command in that menu.

Notes, Cautions, and Warnings

Notes identify additional information about using the Real-Time

Position Management (RPM) Respiratory Gating system that can help

you obtain optimum performance from the hardware or software.

Note: Make sure to familiarize yourself with the information in “Safety
@ ’Features and Procedures” on page 19.

Cautions identify important information about actions or conditions

that can result in minor or moderate injury to personnel or can result

in damage to hardware or data.

CAUTION: Turn off all equipment that is connected to any cables before
& ‘ connecting or removing the cables.

Warnings identify important information about actions or conditions
that can result in serious injury.

WARNING: Bodily fluids, water, and cleaning agents that enter the RPM
Respiratory Gating System components could cause a short circuit,
which could damage the equipment and cause serious bodily injury.

Contacting Support

Support services are available without charge during the 1n1t1
warranty period. If you seek information not included in ts
publication, call Varian Medical Systems support at the m

locations:
94 °

= North America toll-free telephone support +1.8
= Global telephone support +1.702.938.4807 &

Q\
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Global&lephone support for treatment planning +1.702.938.4712

Ordering Addi Q% Documents

o
&

der additional documents, call the following:
North America +1.800.535.5350 (Press 1 for parts)

Global +1.702.938.4700

Communicating Via the World Wide Web

If you have access to the Internet, you will find Varian Medical System
support at the following location:

Oncology Systems — http://www.varian.com/oncy/

Then click Support from the menu list along the left side of the
window.

Sending E-Mail

Send your e-mails to the following locations for support:

Information Management Systems

onc.helpdesk@varian.com
Digital Imaging Management Systems

onc.helpdesk@varian.com
Delivery Systems

onc.helpdesk@varian.com
Treatment Planning Systems

tps.support@us.varian.com
Brachy Therapy Systems

brachy.support@varian.com

s@*. o

Concept Overview \' \)

The RPM Respiratory Gating System 1.7 plays roles&rea@
simulation, treatment planning, and treatment itself

Q
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Two Kinds of Plannipg

Anim study can indicate that delivery of the planned treatment
should take into account the motion of a tumor with the
t’s respiration. The technique of respiratory gating starts and
%)s a treatment beam —metaphorically speaking, opening and
\5 utting a gate that holds in the radiation—according to a pattern of
% breathing. To simulate the respiratory gating treatment technique, the
Q% RPM Respiratory Gating System, working with many imaging
systems under many configurations, synchronizes imaging acquisition
data and breath motion data for two planning approaches:

m  Synchronizing the RPM Respiratory Gating System with the
imaging system at the time images are acquired, using the imaging
device prospectively to plan treatment

m  Synchronizing the RPM Respiratory Gating System with the
imaging system after the images are acquired, using the acquired
images retrospectively to plan treatment

Breathing-Synchronized Image Acquisition

When working with an imaging device, the RPM Respiratory Gating
System 1.7 is used to correlate the time of the acquisition of an image
with a breathing signal it detects. This process is also referred to as
breathing-synchronized image acquisition. The reasons for this
process have to do with modern treatment planning.

Modern treatment planning uses volumetric images produced by CT,
MR and PET scanners. Breathing-synchronized acquisition of these
images ensures that the image used for planning and simulation
corresponds to a known breathing state that can be detected or
reproduced before and during treatment, thereby enabling beam-on
when and only when the patient is in that respiratory state. It is
therefore important that the respiratory gating system used for
treatment be identical to the respiratory gating system used in image
acquisition for planning and treatment simulation.

The next sections discuss how each of these types of imag @* oo
sequences are acquired and what role the RPM Respiratgey ®ati .\

System plays in capturing data about acquisition. o 0
S
X
()
Q¥
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CAUTION: RPM system uses chest wall or abdominal motion as a
surrogafe¥ier the respiration-induced motion of the tumor and other
orga structures within the body. The adequacy of this surrogate
i r for application to the treatment of any specific patient

ition or setup must be based upon clinical evaluation using CT or
uoroscopic imaging and other studies as deemed appropriate. These
judgements are the sole responsibility of qualified medical personnel
using the equipment.

CT or PET Scans

For these image scans, the image formation, acquisition, and storage
processes are performed by an external third party vendor device; this
is the case for third party diagnostic CT, PET and MR scanners.

Because the device is external to the RPM Respiratory Gating System,
a means of synchronization is needed. Breathing synchronization is
achieved by the exchange of synchronization pulses—in real time
during image acquisition—between the external device and the RPM
Respiratory Gating System.

The synchronization scheme for CT or PET scans is prospective in that
the RPM Respiratory Gating System controls image acquisition. It
issues a trigger signal. The imaging device responds to the trigger and
starts or stops the image acquisition.

Since the external imaging device also performs image formation and
storage, there needs to be a means to transfer to the device the
breathing signal and any synchronization tags recorded by the RPM
Respiratory Gating System. Transfer is achieved through a file that the
RPM Respiratory Gating System exports to the computer’s file system.
The file is then read by the imaging device, typically over the facility’s
computer network; removable storage media can also be used.

Special Prospective Synchronizations

Data capture with the prospective approach can also include
synchronization data that can be used retrospectively for \@ tion 0
of CT Scans. For example, the RPM Respiratory Gating , 1 @\o
customized mode, can trigger acquisition of a set of axi sli@&wd
simultaneously record the output pulses from the rt
indicate—more accurately than the trigger —the actu#l onsi@data
acquisition on the CT scanner for each slice. o (,
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4D CT or 4D¢PET Sequences

For th; &ﬂage sequences, the image formation, acquisition, and
sto rocesses are performed by an external third party vendor
; this is the case for third party diagnostic 4D CT, PET and MR

V\Because the device is external to the RPM Respiratory Gating System,

a means of synchronization is needed. Breathing synchronization is
achieved by the exchange of synchronization pulses—in real time
during image acquisition—between the external device and the RPM
Respiratory Gating System.

The synchronization scheme for 4D CT or 4D PET sequences is
retrospective in that both systems can capture synchronization data
that is reconstructed later. This data capture can take the form of the
following examples:

m At the onset of each acquisition interval, the imaging device can
output a pulse—for example, the X-ray-on signal that comes at the
exact time of the start of image acquisition on a CT scanner. The
RPM Respiratory Gating System can sense and record this pulse.

m  The imaging device can tag the acquired raw image data with the
synchronization pulse it receives from the RPM Respiratory Gating
System.

Since the external imaging device also performs image formation and
storage, there needs to be a means to transfer to the device the
breathing signal and any synchronization tags recorded by the RPM
Respiratory Gating System. Transfer is achieved through a file that the
RPM Respiratory Gating System exports. The file is then read by the
imaging device, typically over the facility’s computer network;
removable storage media can also be used.

The file contains a number of flags in addition to the respiration signal,
estimated phase, and the time stamp. This data is later used by the CT
reconstruction software, provided by the CT vendor, to rearrange the
CT slices so that a sequence of volumetric data is created. Each 3D
image corresponds to a phase bin of the breathing cycle. *

«Q

After data capture and export, another system reads the dd#g Tile zﬁ@o
reconstructs and correlates the acquired images with t}bxreath&
data recorded by the RPM Respiratory Gating Systé .v

&\
N
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Breath Motion Tra&ng
The is positioned on the imaging device’s couch in the view of
th Respiratory Gating System’s camera, a charge-coupled device
( ) tracking camera which is sensitive to infrared light. A set of
rared light sources provides the light. The camera's lens fits through
V\a ring on which the light sources are mounted. A small plastic block
Qé placed on the patient moves with the patient’s breath. Circular

reflective markers on the block, reflecting the infrared light, appear in
the video signal that the camera sends to the RPM Respiratory Gating
System. Figure 1 shows a frame in the video signal during a test.

Circular
marker on
block

Figure1 Frame Sent to RPM Respiratory Gating System

physique, clinical condition, and treatment prescription. As a general
rule of thumb, the block can be placed approximately midway
between the xyphoid process (at the base of the sternum) and the
umbilicus. Actual placement should take into account the consistency
of chest wall motion, and you should consult with the treatment
planning team to establish the desired position.

i CAUTION: Placement of the marker block varies based on the patient's
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CAUTION: RPM system is intended for use in the treatment of
lesions her anatomical structures directly affected by respiration
moti Wrticularly in the thorax and upper abdomen. This includes,
bt@ot limited to, regions in the lung, breast, esophagus, liver, and
reas. This can also include regions in the lower abdomen or

vis in cases where patients have significant diaphragm motion in
their respiratory cycle (that is, “belly breathers”). This system is
generally not intended for regions not affected by respiration motion,
such as the head, extremities, or nonmoving bony structures. The
appropriateness of the use of this respiration motion technique is at
the discretion of qualified medical personnel using this equipment.

CAUTION: Use of the RPM system is not limited by patient factors such
as sex, age, weight, and so on, except in those instances where the
Clinac linear accelerator system is so limited (by patient weight, for
example). The system might, however, be limited by a patient
condition such as compromised lung function where there is little or
no motion of the chest wall during respiration, or if the respiratory
cycle is too irregular to adequately define a repeatable gated interval.
The appropriateness of the use of this respiration motion technique is
at the discretion of qualified medical personnel using this equipment.

Markers

The system uses the marker block to track breath motion. Blocks come
with two or six markers. The original RPM Respiratory Gating System
used a two-dot marker block used to track vertical motion. The RPM
Respiratory Gating System 1.7 uses a six-marker block as the basis for
more sophisticated calculations and finer tracking in three dimensions,
although this version retains the capability to track a two-marker block
as well.

When the six-marker block is used, the camera in the RPM Respiratory
Gating System must be calibrated to establish the coordinate system
needed for tracking in three dimensions. Typically, the calibration is
performed during installation of the system. The system has a facility
for checking the calibration as required —for example, at th%ténni
of the working day. If the camera is moved, it must be ¢ ed

The system cannot establish tracking if a dominatin ct— ter

than the marker and with a shape or size consisten’;%h a er—is

located in the field of view. However, once the tracking i% lished,
()

Q\
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the system gnaintains it if such an object enters the field of view —
provide the object does not enters the tracking boundary around
each

ssion

session must be created or opened before the system can use the
images sent by the camera.The session, associated with a specific
treatment field, is the repository for data including the following;:

= All motion data that the system calculates for a patient, based on
the motion of the markers in the images sent by the camera

m  Triggering data generated by the system and received from the
imaging device

The system accounts for a patient's personal data—name and patient
identification. After a patient is established in the system, the system
can then link the patient to sessions created for a patient's field.

There can only be one reference session for a patient’s treatment field.
The system enforces this condition to make sure that treatment
planning, which can result in many treatment sessions, has a
consistent basis.

CAUTION: Keep in mind the following considerations:

s The RPM Respiratory Gating System is designed to cover a wide
range of respiratory patterns. The system can measure down to
submillimeter accuracy. However, placement of the marker block
varies based on the patient's physique, clinical condition, and
treatment prescription. Actual placement should take into account
the consistency of chest wall motion, and you should consult with
the treatment planning team to establish the desired position.

m In addition, the system is capable of tracking respiratory rates
ranging from 6 to more than 25 respiration cycles per minute. If
the system is unable to track the marker motion, the blue squares
at the top left corner of the camera image displayed on the
workstation monitor. Check the patient and marker p051t10n to
establish a reliable signal.

m  Use chest wall or marker motion of at least 4 mm to ob&q o
optimum performance.

Introduction
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Chapter2 _§ystem Description

apter provides a description the essential general functionality
e RPM Respiratory Gating System 1.7.

%

S@%’ng the Software

This section describes the preliminary steps required to use the RPM
Respiratory Gating System 1.7. Refer to the remaining chapters in the
guide for complete details on providing specific types of simulation
and treatment.

To start the RPM Respiratory Gating System 1.7 software:

1. Log in to the Windows XP or Windows 2000 operating system on
the RPM workstation with your username and password.

2. Choose the following items beginning with the Windows Start
menu: Programs > Varian Respiratory Gating 1.7 > RPM
Respiratory Gating System 1.7 1.7.

The RPM Respiratory Gating System 1.7 window opens, along
with the Patient List dialog box.

3. Look at the file path in the title bar of the RPM Respiratory Gating
System 1.7 window and verify that the path—for example,
S:\PatientsData—is a folder with a database of clinical data and
not research data.

o If the database folder displayed is incorrect, do the following:

a. Click Close to close the Patient List dialog box.

b. On the View menu, click System Configuration to open the
System Configuration dialog box to the General tab.

c. Click the first Browse button to open the Database Location
dialog box.

d. Use this standard dialog box to select the correct d aée file 0
.0

and click Open.

N
e. Click OK in the message box about exiting th, &Em tw e
the change take effect. .V

f. Click OK in the System Configuration dialog ox&&\
()

Q¥
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g. O%File menu, click Exit.

% M Respiratory Gating System 1.7 software window
E es.

Softw@Vindow Overview
N\

é The RPM Respiratory Gating System window contains a title bar, a
Q menu bar, a toolbar, and a number of display areas. The title bar of the
main window shows the current patient and treatment session.

Under the standard menu bar and toolbar appear session-specific
areas:

®  Animage area displays video images from either the camera or the
fluoroscope.

m A session panel area displays session information and buttons for
session options or closing the session of the patient.

m A chart area shows the relative phase of the respiratory cycle in a
dial chart and plots the motion data in a moving graph.

At certain times—for example, during recording—a Visual Prompt
area appears in the upper right corner of the main window.

Note: In general, leave the window maximized. Resizing the window is
@ of limited advantage because there is no scrolling.

Menu Bar

The menu bar contains the following menus and submenus:

s File enables you to set up patients and treatment sessions, and
manage and save recorded data with the following commands:

o Select Patient opens the Patient List dialog box, which allows
you to select, create, edit, or delete a patient in the database the
system uses to account for patients and sessions.

12 RPM Respiratory Gating System 1.7 Instructions for Use



o Selgct Session opens the Treatment Fields and Sessions dialog
> which allows you to select, create, or delete a session in the
m database for the currently selected patient.

eload Current Session Data reloads the current session from
\ the database, discarding any data that has been recorded since
the last time the session was saved.

%V\ o Archive/Restore Database launches a Wizard that guides you
% through archiving or restoring database records for specific
Q patients.

o Save saves the most recently recorded data to the current
session.

o Save As creates a new session with the most recently recorded
data. The field for the new session is selected in the Save As
dialog box.

o Export saves a respiratory data file from a recording session to
a predetermined location.

o Exit closes the RPM Respiratory Gating system application.
This command prompts you to save any unsaved recorded
data, then closes the main window.

= View allows you to set program parameters, display detected
gating hardware, and hide or show the status bar.

o Session Options opens the Session Options dialog box which
enables setting of parameters related to the specific session,
including the basis for gating, the type of breathing, the
threshold default value for predicting normal breathing, and
options for audio and visual prompting.

o Detected Hardware displays a message listing all the gating
hardware detected in the RPM Respiratory Gating system
workstation.

o Workstation Log displays a list of times, users, and
workstation events: starting and closing the application.

o System Configuration opens the System Configuration dialog
box which enables setting of installation parameters, including
the system type, video standard, CT interface, file e pécharto
and tracking options. For the most part these para& s bo

should not be changed. X
o Status Bar makes a bar at the bottom of the@: Vj\' YThe

bar presents suggestions and information.
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m  Tools cqntains two options needed by the system for working with
arker block

ibration Check confirms, when the room uses a six-dot
arker block, that the camera has not moved since the last
camera calibration.

\@D Calibration opens a tool for calibrating the camera.
l Help provides access to online help topics.
& o Contents provides direction about documentation.

o About RPM Respiratory Gating System displays a box with
version information.

Toolbar

Use the toolbar buttons to initiate the primary program functions.
Each function applies to the patient session currently open.

Use the buttons of the toolbar in the following ways:

m  Click Camera to display live video from the tracking camera in the
Image window.

m  Click Fluoro (enabled if the workstation is configured for
fluoroscopic simulation) or 2nd Video Ch (enabled if the
workstation is configured for virtual simulation or treatment) to
display video:

o  When you click Fluoro, the system displays live video from the
fluoroscope during a fluoroscopic simulation.

o  When you click 2nd Video Ch, the system displays live video
from the tracking camera during a virtual simulation or
treatment.

Note: There are two video inputs on the PC workstation: One is always
@ connected to the tracking camera; the button for controlling this video
channel is always labeled Camera. When the workstation is installed
in a CT simulator or treatment room, the other video input is also
connected to the tracking camera and the button controlling this
second video channel is labeled 2nd Video Ch. When the workgtation
is installed in a fluoroscopic simulator room, the second VltKOIPUt bo
connected to the fluoroscope and the button controlhng eco

video channel is labeled Fluoro
m  Click Track to begin video tracking and learning %e 111* f
patient respiration motion.
Q\
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s Click V;rify to use on-board imaging as verification of the planned
ore treatment.

gati
L] I%eat to start up a treatment session from a planning session.

" Record to start recording motion and video data. (If you
ave selected Auto start of session recording in the Gating tab of
\ the Options dialog box: when you click Track or Treat, recording
%V begins automatically after four and a half respiratory cycles.)
Q% s Click Stop to stop recording, playback, or gated treatment.
m  Click Pause to temporarily suspend recording, playback, or gated
treatment.

m  Click Playback to start a gated playback recording of motion and
video data.

m  Click Save to save the most recently recorded data to a file.

m  Click Stop Gating to disable gating in treatment mode, or to
disable triggering of the CT scan in virtual simulation data
acquisition.

s Click Enable Gating to enable gated radiation treatment when the
system is in treatment mode. In virtual simulation data acquisition,
click to enable automatic triggering of the CT scanner.

Working with Patient Information

Creating Patient Information

To create information in the system database for a patient, click New
Patient in the Patient List dialog box. The box opens right after the
software is started, and, if no patient information exists in the
database, the Patient Data dialog box opens for the patient’s details as
described below in step 3 The Patient List dialog box can also be
opened from the File menu.

To open the New Patient dialog box and fill in patient data

1. On the File menu, click Select Patient. o&
The Patient List dialog box opens. \'&

X
2. Click New Patient. eo .vo

The Patient Data dialog box opens.

System Description 15
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3. Type the following information:
O %ue patient ID. You can use any unique string of up to 50
racters for the ID. The ID can include upper- and lowercase

$ tters and numbers.

A last name, first name, and, optionally, a middle name or
initial. Each part of the patient name can contain up to 50

%V characters. Names can include upper- and lowercase letters,

spaces, apostrophes, hyphens, and periods.
4. Click OK.

The software enters the new patient information into the database
and adds it to the Patient List dialog box.

Selecting a Patient

To select a patient, scroll through the Patient List dialog box for the
patient’s name and double-click it; you can also click the name and
click Select.

The Patient List dialog box opens in two ways:

m  Right after the software is started

If no patient information exists in the database, the Patient Data
dialog box opens for the patient’s details as described on page 16 in
step 3.

m  After choosing Select Patient from the File menu
To open the Patient List dialog box
1. On the File menu, click Select Patient.

The Patient List dialog box opens.

2. Ifneeded, click a heading of the list, Last Name, First Name, or ID,
to sort it by that heading. To sort the list in the reverse order, click
the heading again.

3. Scroll through the rows of patient details in the list to find the row
with the patient’s name or ID.

16
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4. Doublexlick the row, or click the row and then click Select.

RPl\%} iratory Gating System 1.7 window title bar changes to
patient’s last name and first name. After that, the

tment Fields and Sessions dialog box opens, displaying the
\eference and treatment review sessions available for the patient.

%V\s If there are no sessions for the patient, the New Treatment Field

dialog box opens; see “Adding a New Field” on page 17 for more

Q details.

5. Use the Treatment Fields and Sessions dialog box by doing any of
the following;:

o In the Show drop-down list, choose Reference sessions only or
All sessions.

o Scroll through the rows of sessions to find the row you want to
review, and either double-click the row or click the row and
then click Select. Refer to “The Session” on page 9 for further
details.

o Click Add New Field. See the next section for more details.

Adding a New Field

To add a treatment field for simulation, open the New Treatment Field
dialog box and either select a field name from the list or type the name
in the list.

The New Treatment Field dialog box opens in one of two ways:

m  As described on page page 17 in step 4

m  Asdescribed on page page 17 in step 5

To add a field, refer to the procedure “Selecting a Patient” on page 16
and continue the task here:

6. Inthe New Treatment Field dialog box field list, do one of the
following:
o Select an existing treatment field from the list

o Click Breast Medial to highlight it and type the field’s n&me 0

over it \'
eo "0\)
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7. Click OK.

If th€® i no reference session for the field, the Treatment Fields
sions dialog box closes, and the software opens a decision

§ or creating a reference session.

@ f there is a reference session for the field, a message box opens to
provide a list of options. Click OK to close the message box, and

%V click Cancel to close the New Treatment Field dialog box.

8. Do one of the following:

o Click Yes to create the reference session. Refer to “The Session”
on page 9 for further details.

o Click No to return to the New Treatment Field dialog box.
Refer to step 6

o Click Cancel to return to the Treatment Fields and Sessions
dialog box. Refer to page 17, step 4

Exporting Session Data

To supplement imaging data on the machines that acquire or
reconstruct it, a file of breath motion can be exported from the RPM
Respiratory Gating System. The dialog box to do this can be opened
after a session recording is stopped; use the option Prompt to export a
respiration data file after recording is finished in the Export File tab
of the System Configuration dialog box. This dialog box tab also
displays the option

To export session data, do the following;:

9. At the workstation, press Ctrl-P or click File in the menu bar and
Select Patient in the menu to open the Patients List dialog box.

10. Click a patient’s name and click Select.
The Treatment Fields and Sessions dialog box opens.

11. Click the relevant reference session in the list and then click Select.

The reference session opens in playback. &0 . oo
12. Click Stop in the taskbar. X, \)
13. Click File in the menu bar and Export in the m .vo
14. Fill in the blanks with the identified numbers. \&\

$°
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15. (Optiongl) Click Review to open the Phase Recalculation Review
ﬁx. Review the peak recalculations, and, as needed, add or

dial

d&%’waks and click Save Changes and Exit.
16@ OK to close the file export dialog box.
@ f an export file of the same name exists, then the system prompts
V\ you for permission to delete the existing export file.

é The system displays a message about data being written with a
Q progress bar. When finished, the system displays a message box
with the patient ID, indicating that the file export is complete.

Shutting Down the System

At the end of the day, to shut down the RPM system:
1. In the File menu, click Exit.
The RPM system shuts down and the main window closes.

2. In the Windows taskbar, click Start and then Shut Down or Turn
Off Computer. If prompted, click the Turn Off icon.

Windows shuts down and the RPM workstation turns off.

3. Turn off the camera and illuminator.

Safety Features and Procedures

It is possible that gating simulations have to be stopped for safety
reasons. This section provides descriptions of safety features and
procedures for these tasks.

Stopping Gating

sequence, follow the normal disable-scan procedure for th

you are using. You can also click Stop or Stop Gating on t

Both of these buttons immediately suspend triggerin bse
CT slices, except that when using the Stop Gating , d.%

recording continues. \)
&

Q‘\

System Description 19

If you need to stop an automatically triggered gated CT imagi
C§rstem°
ol




\

A

N

NV
&

CAUTION: Regssing the Stop button on the toolbar does not stop
retros CT X-rays or data collection. Failure to stop the CT scan
ma¥§ in excessive diagnostic X-ray exposure to the patient.

20

RPM Respiratory Gating System 1.7 Instructions for Use



Chapter 3 &ecording CT or PET Simulation Data
_oXwith Prospective Gating

N\
\% reference session, the RPM Respiratory Gating System can record
%V reath motion and other data when connected to a CT or PET imaging
% system. To simulate the respiratory-gated treatment session, the
Q system can use a link to the CT or PET scanner and trigger imaging.
After data is recorded, planning the treatment session involves
adjusting the gated interval in the reference session to compensate for
the delay between triggering and image acquisition.

Although the procedure below works with a patient’s periodic and
regular breathing pattern, the breath-hold technique can also be used
as described on page 26.

Before You Begin

Confirm the following points:
m  The CT or PET scanner is set for an axial scan with automatic
external trigger.

= Any additional CT or PET system setup features have been
activated.

As needed, click View in the menu bar and Session Options in the
menu. Adjust settings in the Gating, Audio, and Visual Prompt tabs
of the Session Options dialog box, and click OK.

21



Monitoring the Eq&%ment and the Patient

CAU eep the following in mind:
a safety precaution, it is important to continuously refer to the

PM system screen while the system automatically triggers the

\5; CT scanner during recording. If you detect power loss to the RPM

workstation, or the system stops responding, immediately stop
CT scanning manually using the procedures for your CT scanner.

s [f the RPM system circuit that issues the trigger signal should stick
in the closed position after power loss to the system, the CT
scanner may continue to perform unwanted scans at incorrect
respiratory states, thus producing the wrong CT images for
planning. Mistreatment could result if the wrong CT image is

used for planning the therapy.

If you detect power loss to the RPM workstation, or the system stops
responding, immediately stop CT scanning manually using the
procedures for your CT scanner.

If patient respiration becomes unstable, the CT system may time-out
before reestablishing periodicity. If so, refer to your department’s
procedures manual for restarting the scan sequence.

If the patient’s movement changes the waveform substantially, the
system stops issuing triggers altogether, even if periodicity is
reestablished. This is because the patient or the marker block may
have changed position.

1. Click Stop on the toolbar to stop recording, then check the patient
and the marker block.

2. Once the patient has been checked, click Track to begin the scan
sequence over again from the beginning.

A dialog box appears asking if you want to save the motion data
just recorded.

3. Click No and then start the recording and gated triggering process
as before.

22
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Procedure ~\

Toa w prospectively-gated images and record breath and
S nization data, do the following:

repare the system.

%V\ If necessary, turn on the workstation and start the RPM
& Respiratory Gating System.

Move the couch to the position of the first slice.

Set up the patient on the couch.

2
3
4. Place a marker block on the patient.
5. Prepare the imaging device.

6

As needed, perform a scout view or any tasks required by pilot
studies.

7. At the workstation, press Ctrl-P or click File in the menu bar and
Select Patient in the menu to open the Patients List dialog box.
8. Do one of the following:
o Click a patient’s name and click Select.
o Click New Patient, fill in the details, and click OK.

9. Establish a session in one of these ways:

o Select a field or type a field name in the New Treatment Field
dialog box and click OK.

o Click Add New Field in the Treatment Fields and Sessions
dialog box, select a field or type a field name in the New
Treatment Field dialog box, and click OK.

o Click an existing session for a field in the Treatment Fields and
Sessions dialog box, click Delete Session to delete it, click Add
New Field, select a field or type a field name in the New
Treatment Field dialog box, and click OK.

10. If tracking has not already started for a new treatment field, then

click Track. o . 0
& &
RS
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11

. Allow & system to learn the extent of the patient’s breathing
motignObserve the row of blue squares at the top left of the image
ar the color of the Record button. A few blue squares and a

Record button mean that the breathing is regular enough for

system to record data.
&Coaeh the patient about what is happening and what the patient

o
&

13

14
15

16
17

18

19

needs to do—for example, following the speech and visual
prompts to maintain a regular breathing pattern.

. (Optional) Allow the system to begin recording automatically and
continue at step 16

. Click Record.

. Allow the planning team to adjust the thresholds of the gated
interval.

. Click Enable Gating.

. Wait for the breath motion to leave the exit target of the gated
interval, and then press the scanner Start button.

Use this approach to avoid starting a scan within the gated
interval.

. Allow the recording and scanning to continue according to the
facility’s protocol or instructions specific to the patient.

. If any interruption to the regular breathing pattern results in the
CT or PET system timing out or the marker block has changed its
position on the patient, do the following:

a. Click Stop on the toolbar to stop recording, then check the
patient and the marker block.

b. Once the patient has been checked, click Track to begin the
treatment session over again.

A dialog box appears asking if you want to save the motion
data just recorded.

c. Click No and then start the recording and gated treatment
process again at step 11

24
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20. When t;ere have been a sufficient number of scans, wait for the

brea tion to leave the exit target of the gated interval, and
th Stop Gating.

é this approach to avoid stopping a scan within the gated
@\nterval.
. Click Stop.
é 22. (Optional) In the file export dialog box, type the information as
prompted —for example, the exam and series numbers.

(Optional) Click Review to open the Phase Recalculation Review
dialog box. Review the peak recalculations, and, as needed, add or
delete peaks and click Save Changes and Exit.

Click OK to close the file export dialog box.

23. If the recording is unsatisfactory, it is possible to start the recording
and scanning process again. To do this, click Track, click Yes to
save the data as a new session, and continue at step 11

Otherwise, continue to the next step.

24. Do one of the following as needed:
o Press Ctrl-S.
o Click Save in the toolbar.
o Click File in the menu bar and Save in the menu.

At this point, the session is now ready for planning.

25. As needed for file export, do the following:
a. Do one of the following:
m  Press Ctrl-E
m  C(lick File in the menu bar and Export in the menu

b. In the file export dialog box, type the information as
prompted —for example, the exam and series numbers.

c. (Optional) Click Review to open the Phase Recalculation
Review dialog box. Review the peak recalculations, and, as
needed, add or delete peaks and click Save Changes alQ Exit. 0

d. Click OK to close the file export dialog box. &0 0O
26. Click Close Patient in the session panel. 0\' 0\'
X

()
¥
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Using Breath-l—j&ld in CT Prospective Simulation Sessions

Wh %EPM Respiratory Gating System is connection to a CT
SC with an automatic triggering feature, the breath-hold
ing type can be used. The some session options must be set

fore you begin the procedure.
B&E You Begin

To prepare the system for using breath-hold breathing techniques, do
the following;:

1. Click View in the menu bar and Session Options in the menu.
The Session Options dialog box opens to the Gating tab.

2. Examine the selection under Breathing Type, and if it is Periodic,
click Breath-hold.

If you have changed the selection from Periodic, a message box
asks if you want to set session options to the defaults commonly
used with the breath-hold breathing type.

3. Click Yes to have the Session Options dialog box set automatically.

4. Click OK.
5. Click View in the menu bar and System Configuration in the
menu.

The System Configuration dialog box opens to the General tab.
6. Click the File Export tab.

7. Examine the option Recalculate phase before respiration data
export. If it is selected, click the check box to clear the check mark.

8. Click OK.

Procedure for Trial Run

The first recording is a practice run from the perspective o@yatk 0
The planning team uses the first recording to set the thréMgolds f

breath-hold level that the patient can comfortably a%@ ar%
()
N

maintain.
X
N
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To accust(gche patient to the a breath-hold technique and set the

1

N
¥
&

2
3
4.
5
6

thresho the following:
B e the system.

necessary, turn on the workstation, start the RPM Respiratory
ating System, and prepare it as described in “Before You Begin”
on page 21.

Move the couch to the position of the first slice.
Set up the patient on the couch.

Place a marker block on the patient.

Prepare the imaging device.

As needed, perform a scout view or any tasks required by pilot
studies.

At the workstation, press Ctrl-P or click File in the menu bar and
Select Patient in the menu to open the Patients List dialog box.
Do one of the following;:

o Click a patient’s name and click Select.

o Click New Patient, fill in the details, and click OK.

Establish a session in one of these ways:

o Select a field or type a field name in the New Treatment Field
dialog box and click OK.

o Click Add New Field in the Treatment Fields and Sessions
dialog box, select a field or type a field name in the New
Treatment Field dialog box, and click OK.

o Click an existing session for a field in the Treatment Fields and
Sessions dialog box, click Delete Session to delete it, click Add
New Field, select a field or type a field name in the New
Treatment Field dialog box, and click OK.

10. If tracking has not already started for a new treatment field, then

11. Allow the patient to relax.

click Track.
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12. Ask th&atient to take and hold a breath to a higher than normal

leve
her level establishes the limits for the vertical scale of
on when the patient holding the breath. The patient should
\ot be able to reach the higher level when breathing normally.

&Ask the patient to relax again and monitor the image area for a

& regular and periodic breathing pattern.

14. When the patient achieves normal and periodic breathing, click
Record in the taskbar and start monitoring the waveform in the

graph.
15. Give the patient a specific sequence of instructions designed to
achieve a deep inhalation state:
m  Breathe out
m  Breathe in to the high level
= Hold breath

16. Repeat step 15 a few times to practice the technique, asking the
patient to relax and breath normally after a breath-hold is finished.

17. Click Stop in the taskbar.
18. Ask the patient to relax and breathe normally.

19. Review the graph and the traces for practice breath-holds, and
decide on the breath-hold level for the patient.

20. Drag the two amplitude threshold lines to the levels just below and
just above the selected breath-hold level while keeping them
separated by the margin you choose to allow for movement during
breath-hold: for example, 0.5 cm. Figure 2 and Figure 3 show an

example.
[
| L
|
[ L
Double-arrow— : |
cursor for | B *
dragging the | _o o
threshold | » .\o
lines ’—‘ :\

"""““"'{0

Figure 2 Selecting the Lower Threshold\ ‘ &&

&°
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Q Figure 3 New Position for the Lower Threshold

21. Choose the length of time for the helical CT or PET scan based on
the observed patient performance during the practice run, and
program the scanner accordingly.

22. Examine the first seconds of each breath hold and determine if
there is unstable motion—for example, a bounce—between the
entry target and the start of the plateau. If there is sufficient
unstable motion to justify delaying a scan during the unstable
motion, do the following:

a. Click View in the menu bar and Session Options in the menu.
The Session Options dialog box opens to the Gating tab.

b. Click the up and down arrowhead buttons under Breath-hold
delay to set the duration of the unstable motion.

c. Click OK.

Procedure for Simulation

After setting the thresholds for the breath-hold level maintained in the
trial run, the system is ready for simulation.

To use a breath-hold technique while acquiring prospectively-gated
images and record breath and synchronization data, do the following:

1. Click Track in the taskbar.
2. Click Yes to save changes to the thresholds.

q’& QO
3. With the patient relaxed and breathing normally, waj & e\O
é?%a’cati%‘n\at

Record button to turn from grey to black. This is anG
tracking has been established. ,v
&

&
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4. Ask th.e&itient to repeat the breathing actions with the
i s you used in step 15 on page 28 to set the vertical scale

instr,
an?%blish the motion reference:

reathe out

® Breathe in to the high level
V\ o Hold breath

é 5. In the taskbar, click Record and monitor the respiration signal in
Q the graph.

6. Continue to instruct the patient as you did during the practice run,
paying attention to the graph and issuing the “hold breath”
command as soon as the breathing signal crosses into the region
between the amplitude thresholds.

The visual prompt to the patient is the yellow or green bar moving
in and out of the dark blue region as shown in Figure 4.

Figure 4 Visual Prompt and Chart During Breath @
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7. Have thg patient follow the moving bar in the visual prompt or the
brea signal in the graph to enable the patient to achieve the
degi reath-hold level and maintain the breathing signal level

iNtRe area defined by the two thresholds. The bar should be

llow and under the dark blue band when the patient is relaxed

@and breathing normally.

%VS. Move the cursor to the Enable Gating button. Do not click.

\

9. Wait for the breathing waveform to fall below the threshold.

10. Perform the following sequence in a smooth succession of actions:
a. Issue a breathe out command as you have done for the patient.

b. Issue a breathe in high command as you have done for the
patient.

c. Click Enable Gating.

d. Issue the voice command to hold breath as soon as the

breathing signal crosses into the region between the amplitude
thresholds.

11. While monitoring the breathing trace for the held breath in the
graph, wait for the CT or PET scan to complete, and then ask the
patient to relax and breathe normally.

If, during the scan, the patient releases the breath-hold, stop the
scan on the scanner.

12. Monitor the breath and at the next appropriate opportunity issue
the breath out, breathe in high, and hold breath instructions as
previously done.

The waveform moves into the gated interval and the slider bar
moves into the dark blue band. Because gating is enabled, a scan is
triggered.

13. While monitoring the breathing trace for the held breath in the
graph, wait for the CT or PET scan to complete, and then ask the
patient to relax and breathe normally.

If, during the scan, the patient releases the breath-hold, stop the
scan on the scanner. o

()
14. Repeat the above two steps until a sufficient number\ﬂscans&\?
been acquired. 0
ST
xS
)
¥
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15.

Click S&)
The Qg,l n mode changes from Acquisition to Planning.

10onal) In the file export dialog box, type the information as

Optional) Click Review to open the Phase Recalculation Review

16.
ompted —for example, the exam and series numbers.
\s (

o
&

17.

18.

19.

20.

dialog box. Review the peak recalculations, and, as needed, add or
delete peaks and click Save Changes and Exit.

Click OK to close the file export dialog box.

If the recording is unsatisfactory;, it is possible to start the recording
and scanning process again. To do this, click Track, click Yes to
save the data as a new session, and continue at step 3 on page 29.

Otherwise, continue to the next step.

Do one of the following as needed:

o Press Ctrl-S.

o Click Save in the toolbar.

o Click File in the menu bar and Save in the menu.

At this point, the session is now ready for planning.

As needed for file export, do the following:
a. Do one of the following:
m  Press Ctrl-E
m  Click File in the menu bar and Export in the menu

b. In the file export dialog box, type the information as
prompted —for example, the exam and series numbers.

c. Click OK to close the file export dialog box.

Click Close Patient in the session panel.
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Chapter 4 &ecording 4D CT Simulation Data for

‘b%Retrospective Gating

Q%

@ reference session, the RPM Respiratory Gating System can record

reath motion and other data when connected to a CT or PET imaging
system producing a 4D image sequence simulating a treatment
session. The data, synchronized with the 4D image sequence on an
image reconstruction workstation, is used to determine a phase-based
gated interval in retrospect. This gated interval is applied to the
reference session in the RPM Respiratory Gating System as a further
step in planning.

Before You Begin

Because the gated interval determined on the image reconstruction
workstation is typically phase-based, the gate option is set to Phase for
the session in the procedure, and the procedure below includes a step
to verify selection of this option.

Settings that regulate recording might need to be changed, depending
on your facility’s protocols or special instructions for the patient.

To check the settings, do the following;:

1. Click View in the menu bar and click Session Configuration in the
menu.

2. Click the CT Triggering tab.

3. (Optional) Click the up or down arrowhead buttons to set or adjust
the numbers of seconds under the label Stop recording if for the
following parameters:

o No first pulse after
o No new pulse after

These settings ensure that recording is stopped if the i
device does not start as anticipated or stops unexpe%

4. Click OK. $ {0

O
\}0
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Proce

o
&

Q
d®

Confirm thqt the CT or PET scanner is set up for 4D CT or PET
acquisiti *Cording to the manufacturer’s protocol and that any
additi&T or PET system setup features have been activated.

To record data synchronized with 4D CT or PET imaging, do the
following:

1. Prepare the system.

If necessary, turn on the workstation and start the RPM
Respiratory Gating System.

Set up the patient on the couch.
Place a marker block on the patient.

Prepare the imaging device.

g e »® N

As needed, perform a scout view or any tasks required by pilot
studies.

6. At the workstation, press Ctrl-P or click File in the menu bar and
Select Patient in the menu to open the Patients List dialog box.
7. Do one of the following:
o Click a patient’s name and click Select.
o Click New Patient, fill in the details, and click OK.

8. [Establish a session in one of these ways:

o Select a field or type a field name in the New Treatment Field
dialog box and click OK.

o Click Add New Field in the Treatment Fields and Sessions
dialog box, select a field or type a field name in the New
Treatment Field dialog box, and click OK.

o Click an existing session for a field in the Treatment Fields and
Sessions dialog box, click Delete Session to delete it, click Add
New Field, select a field or type a field name in th 0
Treatment Field dialog box, and click OK. 0\0

9. Click Session Options, verify or select the Phase @ng of b&'
Gate on Amplitude of Phase area in the Gating TP i\v

&°

34

RPM Respiratory Gating System 1.7 Instructions for Use



10. As nee d adjust settings in the Audio and Visual Prompt tabs of

% n Options dialog box.

1ck Track.

\ > Allow the system to learn the extent of the patient’s breathing
% motion. Observe the row of blue squares at the top left of the image
% area and the color of the Record button. A few blue squares and a
Q black Record button mean that the breathing is regular enough for
the system to record data.

14. Coach the patient about what is happening and what the patient
needs to do—for example, following the speech and visual
prompts to maintain a regular breathing pattern.

15. (Optional) Allow the system to begin recording automatically and
continue at step 17

16. Click Record.

17. Allow the recording and scanning to continue according to the
facility’s protocol or instructions specific to the patient.

18. When the recording is sufficiently long, click Stop.

19. (Optional) In the file export dialog box, type the information as
prompted —for example, the exam and series numbers.

(Optional) Click Review to open the Phase Recalculation Review
dialog box. Review the peak recalculations, and, as needed, add or
delete peaks and click Save Changes and Exit.

Click OK to close the file export dialog box.

20. If the recording is unsatisfactory, it is possible to start the recording
and scanning process again. To do this, click Track, click Yes to
save the data as a new session, and continue at step 13

Otherwise, continue to the next step.

21. Do one of the following as needed:

o Press Ctrl-S. &
(o) o
o Click Save in the toolbar. & °, 0
X 50

o Click File in the menu bar and Save in the m
At this point, the session is now ready for planniyg. i{O
¥
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22. As needged for file export, do the following:
a. ofte of the following;:
Press Ctrl-E.
Click File in the menu bar and Export in the menu.

@b. In the file export dialog box, type the information as

prompted —for example, the exam and series numbers.

é c. (Optional) Click Review to open the Phase Recalculation
Q Review dialog box. Review the peak recalculations, and, as
needed, add or delete peaks and click Save Changes and Exit.

d. Click OK to close the file export dialog box.

23. Click Close Patient in the session panel.
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